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SOLIDWORKS® 2016 Reference Guide Design Intent, Sketching and Sketch Entities

CHAPTER 4: DESIGN INTENT,
SKETCHING AND SKETCH
ENTITIES

Chapter Objective

Chapter 4 provides a comprehensive understanding of Design Intent, Sketching and the
available Sketch Entities in SOLIDWORKS. On the completion of this chapter, you will
be able to:

e Define and incorporate Design Intent in a:
e Sketch, Feature, Part, Assembly and Drawing document.
e Utilize the available SOLIDWORKS Design Intent tools:

e Comments, Design Binder, ConfigurationManager, dimensions, equations, design
tables and features.

e Identify the correct Reference planes:
e 2D and 3D Sketching.
o Insert sketch Reference planes.
e Comprehend the Parent/Child relationship.
e Recognize and address Sketch states:

e Fully Defined, Over Defined, Under Defined, No Solution Found and Invalid
Solution Found.

e Identify and utilize the following Sketch Entities tools:

e Line, Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle,
3 Point Center Rectangle, Parallelogram, Straight Slot, Centerpoint Straight Slot,
3 Point Arc Slot, Centerpoint Arc Slot, Instant3D, Polygon, Circle, Perimeter
Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve,
Point, Centerline, Text, Plane, Route line and Belt/Chain.

e (lassify and utilize the following Block tools:

e Make Block, Edit Block, Insert Block, Add/Remove, Rebuild, Saves Block,
Explode Block and Belt/Chain.

e Recognize and utilize the following Spline tools:
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e Add Tangency Control, Add Curvature Control, Insert Spline Point, Simplify
Spline, Fit Spline, Show Spline Handle, Show Inflection points, Show Minimum

Radius and Show Curvature Combs.

e Reuse an existing 2D Sketch.

Design Intent

What is design intent? All designs are created for a purpose. Design intent is the
intellectual arrangements of features and dimensions of a design. Design intent governs
the relationship between sketches in a feature, features in a part and parts in an assembly.

The SOLIDWORKS definition of design intent is the process in which the model is
developed to accept future modifications. Models behave differently when design

changes occur.

Design for change. Utilize geometry for symmetry, reuse common features, and reuse
common parts. Build change into the following areas that you create: sketch, feature,

part, assembly and drawing.

w1

“¥* When editing or repairing geometric relations, it is considered best practice to edit

the relation vs. deleting it.

Design Intent in a Sketch

Build design intent in a sketch as the profile is created. A
profile is determined from the Sketch Entities. Example:
Rectangle, Circle, Arc, Point, Slot etc. Apply symmetry
into a profile through a sketch centerline, mirror entity and
position about the reference planes and Origin. Always
know the location of the Origin in the sketch.

Build design intent as you sketch with automatic
Geometric relations. Document the decisions made during
the up-front design process. This is very valuable when
you modify the design later.

A rectangle (Center Rectangle Sketch tool) contains
Horizontal, Vertical and Perpendicular
automatic Geometric relations. =

Apply design intent using added uf
Geometric relations if needed. Example: : o
Horizontal, Vertical, Collinear,

Perpendicular, Parallel, Equal etc.
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Example A: Apply design intent to create a square profile.

Sketch a rectangle. Apply the Center Rectangle Sketch tool. 3.00

Note: No construction reference centerline or Midpoint

relation is required with the Center Rectangle tool. Insert S = /,//
dimensions to fully define the sketch. oo Sy
Example B: If you have a hole in a part that must always be | /‘/'%\\ |
16.5mm < from an edge, dimension to the edge rather than e \‘\,\

to another point on the sketch. As the part size is modified, =
the hole location remains 16.5mm < from the edge as
illustrated.

Design Intent in a Feature

Build design intent into a feature by addressing End
Conditions (Blind, Through All, Up to Next, Up to
Vertex, Up to Surface, Offset from Surface, Up to Body
and Mid Plane), symmetry, feature selection, and the
order of feature creation.

Example A: The Extruded Base feature remains symmetric
about the Front Plane. Utilize the Mid Plane End Condition
option in Direction 1. Modify the depth, and the feature
remains symmetric about the Front Plane.

Example B: Create 34 teeth in the model. Do
you create each tooth separately using the
Extruded Cut feature? No.

Create a single tooth and then apply the
Circular Pattern feature. Modify the Circular
Pattern from 32 to 24 teeth.

Design Intent in a Part

Utilize symmetry, feature order and reusing
common features to build design intent into a
part. Example A: Feature order. Is the entire
part symmetric? Feature order affects the part.

Apply the Shell feature before the Fillet feature and
the inside corners remain perpendicular.
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Design Intent in an Assembly

Utilizing symmetry, reusing common parts and using
the Mate relation between parts builds the design
intent into an assembly.

Example A: Reuse geometry in an assembly. The i
assembly contains a linear pattern of holes. Insert one /
screw into the first hole. Utilize the Component

Pattern feature to copy the machine screw to the other

holes.

Design Intent in a Drawing

Utilize dimensions, tolerance and notes in parts and é
assemblies to build the design intent into a drawing.

Example A: Tolerance and material in the drawing.
Insert an inside diameter tolerance +.000/-.002 into
the Pipe part. The tolerance propagates to the S
drawing.

Define the Custom Property Material in the Part. CluieTT N
The Material Custom Property propagates to your

drawing.

w1

‘¥* Create a sketch on any of the default planes:
Front, Top, Right or a created plane or face.

i cE[R[e]®] >
SOLIDWORKS Design  Tse sEE
Intent tools s
R ?m;:ld‘::n Tree Items Y
Comments gerame
@ Add to Libr-ary
Add comments, notes or additional information to b = fjj;;i“””g |2 ads commen:

features or sketches during the design period. This
will aid you or your colleagues to recall and to better
understand the fundamental design intent later of the
model and individual features.

09[/29/2015 07:38 AM David: Customer ABC

Right-click on the name, feature or sketch in the
FeatureManager. Click Comment » Add Comment.
The Comment dialog box is displayed.

Date/Time Stamp] l Cancel ] l Save and Close | 4
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Enter the information. Click Save and Close. A Comments folder is displayed in the
FeatureManager. Double-click the feature in the Comments folder to view the comment.

1 .-

- s

Design Binder

" You can also add a Date/Time stamp to your comment.

Activate the Design binder. Click Options & » System Options
tab > FeatureManager. Select Show from the drop-down menu.
The Design Binder is an embedded Microsoft Word document that
provides the ability for the user to capture a screen image and to

incorporate text into a document.

ConfigurationManager

When you create various configurations for assemblies,
design tables, etc., use the comment area to incorporate a
comment for these configurations.

Dimensions

To be efficient, reuse existing geometry. Provide
dimensions with descriptive names.

Equations

SOLIDWORKS provides a completely redesigned dialog
box for creating and editing equations, global variables and
dimensions.

Add a comment to the end of an equation to provide clarity
for the future. Use descriptive names and organize your
equations to improve

@ [E|R[¢ © >
7

(& Partl (Default<<Default>_Display S

» Comments
History
[ Sensors

- Design Binder

E] Design Journal.doc <Empty>

» [&] Annotations
[E) Equations
€N Material <nat specified
SERIEE
Configurations
= 65; Partl Configuration(s)
[® « Default LRam11
‘*i_, Add Derived Configuration...
Sh%w Preview
Properties...
" Modify

v 287 s[F

BASE sketch h:' r first featureD1

69.54471154mm

T THNAANNNNNREENEEEENARARAR AN RN RRE]

Sensors
» [&] Annotations

Equat|o| Manage Equations..

o— .

2 Materia

W Front PI

Sbﬁrow File Properties
Go To...

Equations, Global Variables, and Dimensions

Clarlty @ T Fiter Al Felds n @™

Evaluates to

|Comments ok

| |[=IGlobal Variables

Import..

Export.

[ Automatically rebuild

[ Link to external file:

Angular equation units:

[#] Automatic solve order

PERE

Help

N
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w1

AR You can specify the units of measurement for global SEER T
variables, and for the values and equations that define the © BossExtrude _,

global variables. You can define the units in the Equations and |. «
modify dialog boxes for dimensions, and in PropertyManagers

From ~

that support equations. [Sketeh plane =
Direction 1 ~

. IB\ind -
Design Tables -1
There are a number of ways to incorporate a comment into a M s
design table. One way is to add “SCOMMENT” to the heading File Propertis 2@ st
of a column. This provides the ability to add a comment in a = A & wet)
design table. — £
Features

Always use descriptive names in the FeatureManager design tree, not the default feature
names such as Boss-Extrudel, Cut-Extrudel, LPatternl, etc. Group important features
toward the top of the FeatureManager design tree.

w1

“¥" Enable the FeatureManager Name feature on W] scrol selected tem into view
creation option: click Options & » System Options %me;:gtt
» FeatureManager » Name feature on creation box. [¥] oynamic ighlight
The Name feature on creation option highlights the [7)use transparent fyout FeatureManager tree in parts/assemblics
feature name when created and allows the feature to e e e T
be named.

Identify the Correct Reference Planes

Most SOLIDWORKS features start with a 2D sketch. Sketches are the foundation for
creating features. SOLIDWORKS provides the ability to create either 2D or 3D sketches.

A 2D sketch is limited to a flat 2D Sketch Plane located on a Reference Plane, face or a
created place. 3D sketches are very useful in creating sketch geometry that does not lie on
an existing or easily defined Plane.

Does it matter where you start
sketching? Yes. When you create a
new part or assembly, the three
default planes are aligned with
specific views. The plane you select
for your first sketch determines the
orientation of the part. Selecting the
correct plane to start your model is
very important.
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2D Sketching/Reference Planes

The three default L reference planes,
displayed in the FeatureManager design tree,
represent infinite 2D planes in 3D space.

They are:
° Front. g;gtlgndary Datum Front
Tertiary Datum
e Top.
e Right.

Planes have no thickness or mass.
Orthographic projection is the process of
projecting views onto parallel planes with L
projectors. The default L datum planes are:

e Primary.
e Secondary. Fomary Datur
e Tertiary.

Use the following planes in a manufacturing
environment:

e Primary datum plane: Contacts the part at a minimum of three points.
e Secondary datum plane: Contacts the part at a minimum of two points.
e Tertiary datum plane: Contacts the part at a minimum of one point.

The part view orientation depends on the sketch plane. Compare the Front, Top and Right
Sketch planes for an L-shaped profile in the following illustration. Remember - the plane
or face you select for the base sketch determines the orientation of the part.

| SR

- 20-Profile - -+ FrontFlane - - TopFlane + -+ -Right-Flaneq]
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The six principle views of Orthographic projection listed in the ASME Y14.3 2009
standard are Front, Top, Right, Bottom, Rear and Left. SOLIDWORKS Standard view
names correspond to these Orthographic projection view names.

ASME Y14.3 2009 Principle View Name: SOLIDWORKS Standard
View:

Front Front

Top Top

Right side Right

Bottom Bottom

Rear Back

Left side Left

w s

_/Q: Overall drafting standard
ANSI is the ANSI

default overall
drafting standard used in the book.

e Displayed are the Front, Top, Right
and Isometric views in Third Angle
Projection.

Tutorial: Default Reference Planes 4-1

Create a New part. Display the default

Reference planes in the Graphics window.

1. Click New O from the Menu bar. The
Templates tab is the default tab. Part is
the default template from the New

SOLIDWORKS Document dialog box.

2. Click OK. The Part FeatureManager is displayed. Use the sketch s
Origin to understand the (x-,y-) coordinate location of the sketch
and to apply sketch dimensions. Each sketch in the part has its own

. .
Orlgll’l. W Top ane
. . W Right Plane
3. Click Front Plane from the FeatureManager design tree. The Lo,?gm

Front Plane is the Sketch plane. The Front Plane is
highlighted in the FeatureManager and in the Graphics

window.

+]
5>

Emckat views

o WG bG W
Al Bracket
car o1 bnger [

mriarn

@ [E[R &€
\é

@) Partl (Default<<Default>_Disg
History

» [&] Annotations
Equations

EE Material <not specified>

Frong Plang

Show the default Reference planes in the Graphics window. 7

Select the Front, Top and Right planes.
4. Hold the Ctrl key down.

5. Click Top Plane and Right Plane from the

FeatureManager design tree.
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6. Release the Ctrl key.
7. Right-click Show ® from the Context toolbar.

8. Click inside the Graphics window. The three planes are
displayed in the Graphics window. Note the Plane icon in
the FeatureManager.

w1

“¥* Rename a feature or sketch for clarity. Slowly click the
feature or sketch name twice and enter the new name when the
old one is highlighted.

Rename the default Reference planes.
9. Rename the Front Plane to Front-PlateA.

10. Rename the Top Plane to Top-PlateB.
11. Rename the Right Plane to Right-PlateC.
12. Rebuild @ the model.

13. Close the model.

3D Sketching/Reference Planes

Design Intent, Sketching and Sketch Entities

Equations
§E Material <not specified>
m Front Plane

N Tof[an| © 1.
™ Rig
I-.Ofi F

© >
¥
@@ Partl (Default<<Default>_Disp
History
Sensors
» [&] Annotations
Equations
§E Material <not specified >
il Front-PlateA
ﬁ Top-PlateB
@ Right-PlateC

L, origin

Create a 3D Sketch in SOLIDWORKS. A 3D Sketch is typically used for advanced
features such as Sweeps and Lofts or when the sketch does not lie on an existing or easily

definable plane. Most basic features are created from a 2D Sketch.

There are two approaches to 3D Sketching. The first approach is called 2D Sketching

with 3D Sketch planes. In this approach, you:
1. Activate a planar face by adding a 3D Sketch plane.
2. Sketch in 2D along the plane.

3. Add 3D Sketch planes each time you are required to move sketch entities to create a

3D sketch.

Using the 2D Sketching with 3D Sketch planes approach provides the ability to:

e Add relations:
e Between planes.
e Between sketch entities on different planes.
e To planes.
e Define planes.

e Move and resize planes.
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Tutorial: 3D Sketching 4-1
Create a simple 2D Sketch using 3D Sketch planes.

1.
2.
3.

7.

Create a New U part. Use the default ANSI Part template.
Click Top Plane from the FeatureManager.

Click 3D Sketch On Plane from the Sketch Consolidated toolbar

as illustrated. 3DSketchl is active.

Click the Line 7 Sketch tool.
Sketch a vertical line through the Origin.

Right-click Exit Sketch (¢ from the Context toolbar. 3DSketchl

is displayed in the FeatureManager and is under defined.

Close the model.

Tutorial: 3D Sketching 4-2

Create the illustrated model. Insert two features: Boss-Extrudel
and Cut-Extrudel. Apply the 3D Sketch tool to create the
Cut-Extrudel feature. System units = MMGS.

1.

Create a New UJ part in SOLIDWORKS. Use the default
ANSI, MMGS Part template.

Right-click Front Plane from the FeatureManager. This is
your Sketch plane.

Click Sketch C from the Context toolbar. The Sketch
toolbar is displayed.

Click the Corner Rectangle [ tool from the Consolidated
Rectangle Sketch toolbar. The PropertyManager is
displayed.

Sketch a rectangle as illustrated. The part Origin is located
in the bottom left corner of the sketch.

Insert dimensions.

6.
7.

Right-click Smart Dimension ¢ from the Context toolbar.

Dimension the sketch as illustrated. The sketch is fully
defined. The sketch is displayed in black.
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[ €], 3D Sketch On Plane

7

@j Part2 (Default<<Default>_Disp
History
Sensors

4 Annotations
Equations
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W Right Plane

L. Origin
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Create the first feature for the model. The Extruded Boss/Base feature adds material to a
part. Extrude the sketch to create the first feature. Apply symmetry.

8. Click Extruded Boss/Base @ from the Features toolbar.

9. Select the Mid Plane End Condition in Direction 1. Enter
100.00mm for Depth in Direction 1. Accept the default
conditions. Click OK ¥ from the Boss-Extrude
PropertyManager.

w1

S The Instant3D tool provides the ability to drag geometry and
dimension manipulator points to resize features or to create new
features directly in the Graphics window. Click the face. Select a
manipulator point. Click and drag. Click a location along the ruler
for the required dimension. The rule increments are set in System

4@ \*
Options. ’\l
10. Create 3DSketchl. 3DSketchl is a four point sketch. Click

3D Sketch On Plane from the Consolidated Sketch toolbar as o P

1llustrated. Sketch | Smart
Dimension | I ~

11. Click the Line 7 Sketch tool. 3DSketch1 is a four point
sketch as illustrated. 3DSketch1 is the profile for %
Cut-Extrudel. sketch

12. Locate the first point of the sketch. Click the back right
bottom point as illustrated. Locate the second point of the
sketch.

13. Click the top left front point as illustrated. Locate the third
point of the sketch.

@ -

o 3D Sketch
EJ, 3D Sketch On Plane

14. Click the bottom right front point as illustrated.

Locate the fourth point of the sketch.

15. Click the back right bottom point as illustrated to close the
sketch.

Create the Cut-Extrudel feature.

16. Click Extruded Cut & from the Features toolbar.
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17. Click the front right vertical edge as illustrated to remove
the material. Edge<1> is displayed in the Direction of
Extrusions box.

18. Click OK v from the Cut-Extrude PropertyManager.
Cut-Extrudel is displayed in the FeatureManager.

19. Close the model.

w1

AR Select the front right vertical edge or the Top face to
remove the required material in this tutorial.

The second approach to create a 3D Sketch in SOLIDWORKS is
3D Sketching. In this approach:

1. Open an existing 3D Sketch.

2. Press the Tab key each time you need to move your sketch
entities to a different axis.

The sketch origin is placed wherever you start the sketch.

Tutorial: 3D Sketching 4-3
Apply the 3DSketch tool to create a 3DSketch using the Tab key
to change Sketch planes.

1. Open 3D Sketching 4-3 from the SOLIDWORKS 2016
folder.

Edit the 3D Sketch.
2. Right-click 3DSketch from the FeatureManager.

3. Click Edit Sketch 2 from the Context toolbar.
3DSketchl is displayed in the Graphics window.

4. Click the Line / Sketch tool. Note: The mouse
feedback icon.

5. Click the right endpoint of the sketch as
illustrated.

6. Press the Tab key to change the Sketch plane
from XY to YZ. The YZ icon is displayed on the
mouse pointer.

7. Sketch a line along the Z axis approximately
130mm as illustrated.

8. Press the Tab key twice to change the sketch
plane from YZ to XY. The XY icon is displayed
on the mouse pointer.
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30mm.

1,507
L

9. Sketch a line back along the X axis approximately /L

10. Sketch a line on the Y axis approximately 30mm.
11. Sketch a line along the X axis of approximately 130mm.

Deselect the Line Sketch tool.
12. Right-click Select. View the 3D Sketch.

13. Rebuild @ the model.

14. Close the model. = ——
Tutorial: 3D Sketching 4-4 @ Hole Specification

Utilize the 3D Sketch placement method. Insert a hole on a i
cylindrical face using the Hole Wizard. R [
1. Open 3D Sketching 4-4 from the SOLIDWORKS 2016 folder. Q “"’; n

Note: With a 3D sketch, press the Tab key to move between
planes. w

2. Click the Hole Wizard @ feature tool.

Create a Counterbore, ANSI Inch, Socket Head Cap Screw
fastener Type. Size - Y4. Fit - Normal. End Condition -
Through All with a .100in Head clearance.

4. Click the Positions Tab.
Click the 3D Sketch button. The Hole

Position PropertyManager is displayed. it
SOLIDWORKS displays an active 3D e N
. . . -- Head AN DShuw custom sizing |
interface with the Point XY % tool. ) om0 End Condition X

:- I £ [#] Mear side countersink

“¥" When the Point tool is active, wherever you
click, you will create a point.

Dimension the sketch.

6. Click the cylindrical face of the model as illustrated. The
selected face is displayed in orange. This indicates that an
OnSurface sketch relations will be created
between the sketch point and the cylindrical
face. The hole is displayed in the model.

7. Insert a .25in dimension between the top face
and the sketch point.

Locate the point angularly around the cylinder.
Apply construction geometry.
8. Display the Temporary Axes.
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9. Click the Line e Sketch tool. Note: 3D Sketch is still
activated.

10. Ctrl + Click the top flat face of the model. This moves the
red space handle origin to the selected face. This also
constrains any new sketch entities to the top flat face. Note

e
the mouse pointer 77K jcon.

11. Move the mouse pointer near
the center of the activated top
flat face as illustrated. View the
small black circle. The circle
indicates that the end point of
the line will pick up a
Coincident relation.

12. Click the center point of the
circle.

13. Sketch a line so it picks up the AlongZ
sketch relation. The cursor displays the
relation to be applied. This is a very
important step.

Deselect the Line Sketch tool.
14. Right-click Select.

15. Create an AlongY sketch relation between
the center point of the hole on the
cylindrical face and the endpoint of the
sketched line. The sketch is fully defined.

Add Relations -~

16. Click OK from the PropertyManager.
17. Click OK to return to the Part zm St 14 Dot o
FeatureManager. History
[@ Sensors
18. Expand the FeatureManager and view the * B Amnottions
results. The two sketches are fully defined. fg:;:jl“y
One sketch is the hole profile, the other W Front Plane
sketch is to define the position of the feature. N
19. Close the model. , EZZQ'L
Wl (3 CBORE for 1/4 Socket Head
R . . . i [ 3DSketch1
Create a second sketched line and insert an angle dimension K sketch2

between the two lines. This process is used to control the position of

the center point of the hole on the cylindrical face as illustrated. Insert

an AlongY sketch relation between the center point of the hole on the cylindrical face and
the end point of the second control line. Control the hole’s position with an angular
dimension.
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“¥* The main advantage of the 3D Sketch placement method is that it can place a set of

holes on any set of solid faces, regardless of whether they are at different levels, or are

non-parallel. A limitation: 3D sketches can be fairly cumbersome and difficult. See
section on 3D Sketching in SOLIDWORKS Help for additional details.

2D Sketching/Inserting Reference Planes

Reference Planes are geometry created from existing planes, faces,

0y

Geometry

vertices, surfaces, axes, and or sketch geometry. To access the Plane N

PropertyManager, click Insert > Reference Geometry > Plane from
the Menu bar or click the Plane [ tool from the Consolidated

Reference Geometry Features toolbar.

Plane Tool

The Plane ® tool uses the Plane
PropertyManager. The Plane
PropertyManager provides the following
selections:

o First Reference. Select a face, plane
or edge to create a reference plane.
The options are available:

e Reference Entities. Displays the
selected planes either from the
FeatureManager or from the
Graphics window.

e Parallel. Creates a plane parallel
to the selected plane. For
example, select a face for one
reference and a point for another
reference. The created plane is
parallel to the face and
coincident to the point.

e Perpendicular. Creates a plane perpendicular to the
selected reference. For example, select an edge or curve

W

Reference | Curves Instant3D

ﬂ Plane
7 Axis

o Point
@ Center of Mass
®fl Mate Reference

}- Coordinate System

SE[B[¢]S]

[ﬂ Plane
« B =

S E[B[®]S]

[ﬂ Plane
« B =

Message

Select references and
constraints

First Reference

7] |

Second Reference

7 |

Third Reference

Message

Fully defined

First Reference

@ IFace< 1>

N Parallel
m Perpendicular

W Coincident
“l'“‘ 90.00deg

for one reference and a point or vertex for another

reference.
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Coincident. Creates a plane
through a point coincident to a
plane or a face.

Project. Projects a singular entity
such as a point, vertex, origin, or
coordinate system onto a non-planar
surface. Select the sketch point and
the model surface. Two options
appear in the PropertyManager:

e Nearest location on surface.
e Along sketch normal.

Tangent. Creates a plane tangent to
cylindrical, conical, non-cylindrical,
and non-planar faces. Select a
surface and a sketch point on the
surface. The plane is created tangent
to the surface and coincident to the
sketch point.

At Angle. Select a plane or planar
face and select an edge, axis, or
sketch line. You can specify the

SOLIDWORKS® 2016 Reference Guide

SESEE

JIEG}E

m Plane [ﬂ Plane
R 48 XK B
Message A Message ~
Select references and Fully defined
constraints
First Reference ~
First Reference A~
@ IFace<1>
@ IVerte)(<1>
Parallel
Coincident

Project
Gl [0 |

Perpendicular

Coincident

[ | 90.00deg |

Second Reference A

@ | 2.50mm |

all

Third Reference ~

I% Mid Plane

all

Options A

Flip normal

number of planes to create. Enter the angle value in the

angle box.

Offset Distance. Creates a plane parallel to a plane or
face, offset by a specified distance. You can specify the
number of planes to create. Enter the Offset distance value

in the distance box.

e Reverse direction. Reverses
the direction of the angle if
required.

e Numbers of Planes to
Create. Displays the selected
number of planes.

Mid Plane. Creates a mid-plane
between planar faces, reference
planes, and 3D sketch planes.
Select Mid Plane for both
references.
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Tutorial: Reference Plane 4-1

Create three Reference planes using the Offset Distance option
from the Plane PropertyManager.

1. Create a New L part. Use the default ANSI Part template.
Set system units to MMGS.

2. Display an Isometric view.

3. Right-click Top Plane from
the FeatureManager design
tree.

4. Hold the Ctrl key down.

5. Click and drag the
boundary of the Top Plane
upwards in the Graphics
window. The Plane
PropertyManager is

displayed. Top Plane is displayed in the First Reference box.

6. Release the Ctrl key and mouse pointer.

7. Enter 25mm in the Distance. The Plane is offset by
25mms.

8. Enter 3 in the Number of planes to create box.

9. Click OK ¥ from the Plane PropertyManager.
Planel, Plane2 and Plane3 are created and
displayed in the Graphics window. Each Plane is
offset from the Top Plane a distance of 25mm.

10. Close the model.

Tutorial: Reference Plane 4-2

Use the Plane PropertyManager to create two angled

Reference planes from an edge at a 45 degree angle.

1. Open Reference Plane 4-2 from the
SOLIDWORKS 2016 folder.

2. Click Right Plane from the FeatureManager
design tree.

3. Click Insert > Reference Geometry > Plane from
the Menu bar. The Plane PropertyManager is
displayed. Right Plane is displayed in the First
Reference box.

4. Click the At angle button.
5. Enter 45deg for Angle.
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6. Click the front vertical edge of Extrudel as illustrated. Do not select the midpoint.
Edge<1> is displayed in the Selections box. The model is fully defined.

7. Enter 2 in the Number of planes to create box.

8. Click OK ¥ from the Plane PropertyManager. Planel and
Plane?2 are displayed in the FeatureManager and in the
Graphics window.

9. Close the model. First Reference
! _
Tutorial: Reference Plane 4-3 . B coinocern
oinciden
Use the Plane PropertyManager to m project
create a Reference plane using =
three vertices (Coincident) to the IGi‘ 0

Extrudel feature.

1. Open Reference Plane 4-3
from the SOLIDWORKS
2016 folder.

2. Click Insert > Reference
Geometry > Plane. The @[
Plane PropertyManager is Third Reference

diplayed N

3. Click three Vertices as . PR Coincident
illustrated. Vertex<1>, =
Vertex<2> and EI Project
Vertex<3> are displayed l@‘ L
Options A

Second Reference

. Coincident
Project

in the Reference Entities
boxes. The model is fully
defined.

4. Click OK ¥ from the
Plane PropertyManager.
The angled Planel is
created and is displayed in
the FeatureManager and the Graphics window.

5. Close the model.

w s

e Fully define all sketches in the model. However,
there are times when this is not practical, generally when

using the Spline tool to create a complex freeform shape.

Page 4 - 18



SOLIDWORKS® 2016 Reference Guide

Tutorial: Reference Plane 4-4

Use the Plane PropertyManager to create a Reference plane
parallel to an existing plane, through a selected point.

1.

Open Reference Planes 4-4 from the SOLIDWORKS 2016
folder.

Click the Plane [ tool from the Consolidated Reference
Geometry Features toolbar. The Plane PropertyManager is
displayed.

Click the front top right vertex.

Click the Right Plane from the fly-out FeatureManager. The
model is fully defined.

Click OK + from the Plane PropertyManager. Planel is
created and is displayed in the FeatureManager and Graphics
window.

Close the model.

Design Intent, Sketching and Sketch Entities

Yy r
Reference | Curves ™
Geometry
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o Point
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2l Mate Reference

Parent/Child Relationship

A Parent feature or sketch is an existing feature or sketch on which others depend on.
Example of a Parent feature: An Extruded feature is the Parent feature to a fillet which
rounds the edges.

When you create a new feature or sketch which is based on other features or sketches,
their existence depends on the previously built feature or sketch. The new feature or
sketch is called a Child feature or a Child sketch. Example of a Child feature: A hole is
the child of the Base-Extrude feature in which it is cut.

Tutorial: Parent-Child 4-1

View the Parent/Child relationship in an assembly for a feature
and a sketch from a component.

1.

Open the AirCylinder Linkage assembly from the
SOLIDWORKS 2016\Solutions folder.

Expand RodClevis<1> from the AirCylinder Linkage
assembly FeatureManager.

Right-click Base-Extrude.

Click Parent/Child. The Parent/Child Relationships dialog
box is displayed. View the Sketch?2 relationships.

Click Close from the Parent/Child Relationships dialog
box.
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View the Parent/Child Relationships for a feature.

SOLIDWORKS® 2016 Reference Guide

6. Right-click Sketch2 from Base-Extrude in the FeatureManager design tree.

7. Click Parent/Child. View the Base-Extrude feature relationships.
8. Click Close from the Parent/Child Relationships dialog box.
9

Close the model.

Sketch States

Sketches can exist in any of five states. The state of the sketch is displayed in the status
bar at the bottom of the SOLIDWORKS window. The five sketch states in

SOLIDWORKS are:

n s
i

Color indicates the state of the individual Sketch entities.

1. Under Defined. Inadequate definition of the sketch, (blue). The FeatureManager

displays a minus (-) symbol before the Sketch name.

2. Fully Defined. Complete information, (black). The FeatureManager displays no

symbol before the Sketch name.

3. Over Defined. Duplicate dimensions and or relations, (orange -red). The
FeatureManager displays a (+) symbol before the Sketch name. The What’s Wrong

dialog box is displayed.

4. Invalid Solution Found. Your sketch is solved but results in invalid geometry.
Example: such as a zero length line, zero radius arc or a self-intersecting spline

(yellow).

5. No Solution Found. Indicates sketch geometry that
cannot be resolved, (Brown).

w 1

“¥" The SOLIDWORKS SketchXpert is designed to
assist in an over defined state of a sketch. The
SketchXpert generates a list of causes for over defined
sketches. The list is organized into Solution Sets. This tool
enables you to delete a solution set of over defined
dimensions or redundant relations without compromising
your design intent.

w1

A Click Options & > System Options > Sketch, and
click the Use fully defined sketches option to use fully
defined sketches for created features.
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w1

Design Intent, Sketching and Sketch Entities

AR Apply dimensions and relations calculated by the SOLIDWORKS application to
fully define sketches or selected sketch entities. Use the Fully Defined Sketch

PropertyManager.
Sketch Entities o -

G Partial Ellipse gle

U Parabola e
Sketch entities provide the ability to create N\ Conic <> 3 Point Comer Rectangle
lines, rectangles, parallelograms, circles i © 3 Point Center Rectangle

> Y gles, p . g > ’ fV spline [T Parallelogram

etc. during the sketching process. To access | & styie Spline e —
the available sketch entities for @ spline on Surface @ Centerpoint Straight Slot
SOLIDWORKS, click Tools » Sketch & Equation Driven Curve & 3 Point ArcSlot
Entities from the Menu bar menu and select | ° "o €2 Centerpoint Arc Slot
the required entity. This book does not go < Centeriine © Polygon
over each individual Sketch entity in full ™\ Midpoint Line @ cirde
detail but will address the more advanced A :ﬂ O
entities. e 5 comepem e
To obtain additional information of each & Bett/Chain ¢ 3 Point Arc
sketch entity, activate the sketch entity and Gistomiza e

click the question mark & icon located at
the top of the entity PropertyManager or click Help >
SOLIDWORKS Help Topics from the Menu bar and search by
using one of the three available tabs: Contents, Index, or Search.

Line Sketch Entity

S/E[R[e[€]
The Line Sketch entity tool provides the ability to sketch multiple / Insert Line 7
2D lines in a sketch. The Line Sketch entity uses the Insert Line v x
PropertyManager. The Insert Line PropertyManager provides the
following selections:

Message -~

Edit the settings of the next new
line or sketch a new line.

e Orientation. The Orientation box provides the following
options:

Orientation -~
(@) As sketched
7 Horizontal
() vertical
() Angle

e As sketched. Sketch a line in any direction using the click
and drag method. Using the click-click method, the As
sketched option provides the ability to sketch a line in any
direction, and to continue sketching other lines in any
direction, until you double-click to end your process.

Options ~
I:‘ For construction
I:‘Inﬂni‘te length
I:‘ Midpoint line

e Horizontal. Sketch a horizontal line until you release your
mouse pointer.

e Vertical. Sketch a vertical line until you release your mouse pointer.

e Angle. Sketch a line at an angle until you release your mouse pointer.
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e Options. The Options box provides two line types. They are:

Options ~
e For construction. Converts the selected sketch entity to [¥]For construction
construction geometry. [Cinfinite length
. . . . . Parameters ~
¢ Infinite length. Creates a line of infinite length which you ~ =

can later trim in the design process.
|l“ 24,90556249°

e Midpoint line. Create a line that is symmetrical from the
mldell'It Of the line. Additional Parameters hd

e Parameters. You can specify any appropriate combination of the following
parameters (or Additional Parameters) to define the line if the line is not constrained
by relations. When you change one or more parameters, the other parameters update
automatically.

w1

“¥* Use Construction geometry to assist in creating your sketch entities and geometry
that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a
centerline.

w1
“¥" The plane or face you select for the Base sketch determines the orientation of the
part.

Rectangle and Parallelogram Sketch Entity |© E[E[¢[€]

1 Rectangle

The Rectangle Sketch entity tool provides the ability to sketch a v
Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle and Rectangle Type -
a 3 Point Center Rectangle. The Parallelogram Sketch entity 5 (=
provides the ability to sketch a Parallelogram. :
The Rectangle and Parallelogram Sketch entity uses the O @ i~
Consolidated Rectangle PropertyManager. The Rectangle [F]add construction lines
PropertyManager provides the following selections: Parameters A
e Rectangle Type. The Rectangle Type box provides five w22

selections. They are: [0

= 0.00
e Corner Rectangle. Sketch a standard rectangle at a corner
e_ | 0.00

point. Click to place the first corner of the rectangle, drag, v
and release when the rectangle is the correct size and shape. | %

e |0.00

e Center Rectangle. Sketch a rectangle at a center point.
Click to define the center. Drag to sketch the rectangle with |
centerlines. Release to set the four edges. + | 000

0.00

i 1 i LI i i i i

¢ 3 Point Corner Rectangle. Sketch a rectangle at a selected
angle. Click to define the first corner. Drag, rotate, and then release to set the
length and angle of the first edge. Click and drag to sketch the other three edges.
Release to set the four edges.
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3 Point Center Rectangle. Sketch a rectangle with a center

point at a selected angle. Click to define the first corner.
Drag and rotate to set one half the length of the centerlines.
Click and drag to sketch the other three edges and
centerlines. Release to set the four edges.

Parallelogram. Sketch a standard parallelogram. A
Parallelogram is a rectangle whose sides are not horizontal
or vertical with respect to the sketch grid. Click to define
the first corner. Drag, rotate, and then release to set the
length and angle of the first edge. Click, rotate, and drag to
set the angle and length of the other three edges. Release to
set the four edges.

e Options. For construction.

e Parameters. Specify the appropriate combination of
parameters to define the rectangle or parallelogram if they are
not constrained by relations.

Slot Sketch Entity

The Slot Sketch entity tool provides the ability to sketch a Straight
Slot, Centerpoint Straight Slot, 3 Point Arc Slot and a Centerpoint
Arc Slot from the Consolidated Slot toolbar.

The Slot Sketch entity uses the Consolidated Slot
PropertyManager. The Slot PropertyManager provides the
following selections:

e Slot Type. The Slot Type box provides four selections. They

arc:

Straight Slot. Sketch a three
point slot.

Centerpoint Straight Slot.
Sketch a three point slot
located at an Origin or
centerpoint.

3 Point Arc Slot. Sketch a four
point arc slot.

Centerpoint Arc Slot. Sketch a
four point arc slot located at an
Origin or reference point.
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¢ Add dimensions. Insert dimensions as
you sketch the slot.

SOLIDWORKS® 2016 Reference Guide

e C(Center to Center. Insert center to
center dimension if the Add 31.73
dimensions box is checked.

e Overall Length. Insert overall length
if the Add dimensions box is checked.

e Parameters. Provides the ability to specify the appropriate
combination of parameters to define slot if they are not
constrained by relations. The parameters box provides the
following options: Center X Coordinate, Center Y

Coordinate, Radius of Arc, Angle of Arc, Slot Width, Slot

Length.

Tutorial: Slot Sketch - Instant3D 4-1

Utilize the Slot Sketch tool. Create an Extruded Boss/Base and
Extruded Cut feature using the Instant3D tool.

1. Create a New UJ part. Use the default ANSI, IPS Part
template.

2. Right-click Front Plane from the FeatureManager.

3. Click Sketch C from the Context toolbar. The Sketch
toolbar is displayed.

4. Click Centerpoint Straight Slot @ from the
Consolidated Slot toolbar as illustrated. The Slot
PropertyManager is displayed. If needed, uncheck
the Add dimension box.

(:x 0.00mm
(s, 0.00mm
& 31.72687253mm

8 64.54777514mm

Parameters ~

4 4 4% 4

@ - - |

PLRE 0|6

Straight Slot
Centerpoint Straight Slot
3 Point Arc Slot
Centerpoint Arc Slot

5. Click the Origin.
6. Click a position directly to the right of the Origin.

7. Click a position directly above the second point as
illustrated.
Dimension the slot sketch.

8. Right-click Smart Dimension € from the
Context toolbar in the Graphics window.

9. Dimension the model as illustrated. The —
sketch is fully defined. Note the location of

the Origin.
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Apply the Instant3D tool. Create an Extruded Boss/Base feature. .

The Extruded Boss/Base feature adds material to a part. Note: Edit RefeEnce c}r{es Inst;‘;-:ts[)
the feature, and view the PropertyManager to confirm that you Geometry
picked the correct dimension with the on-screen ruler. The
Instant3D tool does not provide various End Conditions for
Design Intent.

Exit Sketchl.

10. Right-click Exit Sketch & Note: Instant3D
is active by default. If needed click Instant3D
from the Features tab.

11. Display an Isometric view.

Create an Extruded Boss/Base feature with a

default Blind End Condition.

12. Click the top edge as illustrated. A green
arrow is displayed. Drag the arrow forward
and click the on-screen ruler approximately
0.25in.

13. View Boss-Extrudel in the FeatureManager. Direction 1 ~
14. Edit Boss-Extrudel in the FeatureManager. g -]
15. Enter Depth = .30in. Click OK ¥ from the 7 I

PropertyManager. & [p300m =
16. Display & Frontview. @) =
17. Right-click the Front face. This is your Sketch plane. Ot osers

18. Click Sketch C from the Context toolbar. The Sketch
toolbar is displayed.

19. Click the Circle © Sketch tool.

20. Sketch a circle centered at the Origin as illustrated.

Exit the Sketch.
21. Right-click Exit Sketch.

22. Display an Isometric view.

Create an Extruded Cut feature.
23. Click the circumference of the sketch as illustrated. A green
arrow is displayed.

24. Click and drag the arrow backwards to create a hole in the
model. Note: The default End Condition is Blind.

25. Release the mouse icon behind the model. The Cut-Extrudel
feature is displayed. View the model.
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26. Close the model.

Polygon Sketch Entity

S/E[R[&[€]

(=) Polygon
The Polygon Sketch entity tool provides the ability to create v
equilateral polygons with any number of sides between 3 and
Options ~

40. The Polygon Sketch entity uses the Polygon
PropertyManager. The Polygon PropertyManager provides the
fOHOWil’lg selections: Parameters ~

o Existing Relations. The Existing Relations box displays @ ° -
information on existing relations of the polygon sketch. @ nscribed circle

(©) Circumscribed circle
e Add Relation. The Add Relation box displays the selected

[C]For construction

»

; . . (% 0000 i
relations to the points and lines of your polygon sketch. & omm -

w1 ¥ -
“¥* You cannot add a relation to a complete polygon. Youcan | @ ®5%7¢ .
only add a relation to the points and lines of the polygon. [y oo :

e Options. The Options box provides the following selection:

e For construction. Not selected by default. Converts the
selected sketch entity to construction geometry.

e Parameters. The Parameters box provides the ability to
specify the appropriate combination of parameters to define
the polygon. When you modify or change one or more
parameters, the other parameters update automatically.

The available selections are: o
. . ° 3
e Number of Sides. Sets the number of sides in your /'/d O
polygon. /= \*ﬂ
e Inscribed circle. Selected by default. Displays an g k £> B
inscribed circle inside the polygon. This option /
defines the size of the polygon. The circle is N / o
construction geometry. \n‘x:"’“_-/n
e Circumscribed circle. Displays a circumscribed
circle outside of the polygon. This option defines the
size of the polygon. The circle is construction - °""°,\\D
geometry. /v \
o o
e Center X Coordinate. Displays the X coordinate for =
the center of your polygon. A o)
C\o - J/ ]
D\“‘- .W—'/D
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Tutorial: Polygon 4-1
Create a new part using the Polygon Sketch entity.

e Center Y Coordinate. Displays the Y coordinate for the o=
center of your polygon. Ve N
. . o /= N
e Circle Diameter. Displays the diameter of the inscribed or 4] L o
circumscribed circle. K . x _ _;’D@
e Angle. Displays the angle of rotation. N e

e New Polygon. Creates more than a single polygon without
leaving the PropertyManager.

1. Create a New L part. Use the default ANSI Part template.
2. Right-click Top Plane from the FeatureManager design tree.
This is your Sketch plane.
3. Click Sketch C from the Context toolbar. The Top Plane
boundary is displayed in the Top view.
4. Click the Cirele & Sketch tool. The Circle =
PropertyManager is displayed. " @ - A |Entities Entities
5. Sketch a circle centered at the origin. E&r AR . .
Insert a polygon. u—pn|lygnn |
6. Click Tools > Sketch Entities > Polygon from | Sketches a polygon. You can change
the Menu bar or click Polygon from the Sketch B the number of sides after sketching
toolbar. The Polygon PropertyManager is — the polygon.
displayed.
7. Sketch a Polygon centered at the Origin larger than the o '“—\\n
circle as illustrated. 4 N
8. Click OK ¥ from the Polygon PropertyManager. *
9. Rebuild ® the model. View the created Polygon in the ©

10. Close the model.

w1

-

* For illustration purposes, the Reference planes and grid are
hidden.

Graphics window.
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Circle Sketch and Perimeter Circle
Sketch Entity

The Circle Sketch and Perimeter Circle Sketch entity tool
provides the ability to control the various properties of a
circle.

The Circle Sketch and Perimeter Circle Sketch entity uses the
consolidated Circle PropertyManager. The consolidated
Circle PropertyManager provides the following selections:

Circle Type. Provides the ability to select either a center
based circle or a perimeter-based circle sketch entity.

Existing Relations. The Existing Relations box provides
the following options:

e Relations. Displays the automatic relations
inferenced during sketching or created manually with
the Add Relations tool. The callout in the Graphics
window is highlighted when you select a relation in
the dialog box. The Information icon in the Existing
Relations box displays the sketch status of the
selected sketch entity. Example: Under Defined,
Fully Defined, etc.

Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible
for the selected entity.

Options. For construction. Not selected by default.
Converts the selected entity to construction geometry.

Parameters. Specifies the appropriate combination of
parameters to define the circle if the circle is not
constrained by relations. The available selections are:

e Center X Coordinate. Sets the Center X Coordinate
value.

SOLIDWORKS® 2016 Reference Guide

S E|R[|O]

@ Circle

v

Circle Type

1

nZ
OF
Zz

Existing Relations

i

@ Under Defined

Add Relations

Options
[ For construction

Parameters

(:x 0.00

(s, 000

ﬁ'\- 15.00721787

1 1% 4>

e Center Y Coordinate. Sets the Center Y Coordinate value.

e Radius. Sets the Radius value.
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The Perimeter Circle Sketch entity provides the ability to define
a circle using 3 points along its perimeter. This sketch entity is
very useful when you are not concerned about the location of the

center of the circle.

Tutorial: Perimeter Circle 4-1
Create a Perimeter Circle sketch.

1. Create a New L part. Use the default ANSI Part template.
2. Right-click Front Plane from the FeatureManager. This is

your Sketch plane.
3. Click Sketch C from the Context toolbar.

4. Click the Line e Sketch tool. The Insert Line
PropertyManager is displayed.

5. Sketch two lines as illustrated.
Sketch a circle that is tangent to both lines.

6. Click Perimeter Circle from the Consolidated Circle ~ 9) s

Sketch toolbar. The Circle PropertyManager is
displayed.

7. Click each line once.

8. Click a position as illustrated to determine the size of ©
the circle. The X coordinate, Y coordinate, and Radius
are displayed in the Parameters box. The two lines are
tangent to the circle. You created a simple circle using

the Perimeter Circle sketch entity.

9. Click OK ¥ from the Circle PropertyManager. View * L

the model.

10. Rebuild # the model.
11. Close the model.

w s

“¥" If the two lines change, the circle remains
tangent to the lines.

w s

“¥" In System Options, apply the Ghost image on
drag option. The option displays a ghost image of a
sketch entities' original position while you drag the
sketch in the Graphics window.
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Centerpoint Arc Sketch
Entity

The Centerpoint Arc Sketch entity tool
provides the ability to create an arc
from a center point, a start point, and
an end point. The Centerpoint Arc
Sketch entity uses the consolidated
Arc PropertyManager.

The Arc PropertyManager controls the
properties of a sketched Centerpoint
Arc, Tangent Arc and 3 Point Arc.

The consolidated Arc
PropertyManager provides the
following selections:

SOLIDWORKS® 2016 Reference Guide

Parameters

(=, |00

(s, |0.00

> |ooo
G

¢ [0.00

|0.00

|0.00

e
<e x¢

A

[000

%3

|0.00°

Existing Relations

i

@ Under Defined

Add Relations

Fix

Options
[T For construction

e Arc Type. Provides the ability to select a Centerpoint Arc,
Tangent Arc or 3 Point Arc sketch entity.

o Existing Relations. The Existing Relations box provides the

following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add

Relations tool. The callout in the Graphics window is

highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

e Add Relations. Provides the ability to add relations to the

selected entity. Displays the relations which are possible for

the selected entity.

e Options. For construction. Converts the selected entity to

construction geometry.

e Parameters. Provides the ability to specify any appropriate

combination of parameters to define your arc if the arc is
not constrained by relations. The available selections are
Center X Coordinate, Center Y Coordinate, Start X

Coordinate, Start Y Coordinate, End X Coordinate, End

Y Coordinate, Radius and Angle.
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Tutorial: Centerpoint Arc 4-1
Create a Centerpoint Arc sketch.
1. Create a New U part. Use the default ANSI

N, R=4212
Part template. L
2. Right-click Front Plane from the ;"‘ _,-"f
FeatureManager. This is your Sketch plane. ! .

3. Click Sketch C from the Context toolbar.
4. Click the Line e Sketch tool.

Sketch a horizontal line through the origin as
illustrated.

6. Click Centerpoint Arc ** from the
Consolidated Arc Sketch toolbar. The Arc
icon is displayed on your mouse pointer. o

7. Click a location on the horizontal line left
of the origin. Do not pick the origin or the &
endpoint. £ R=

8. Click a position to the right and up on the
horizontal line.

9. Drag to set the angle and the radius of the arc.

10. Release the mouse button to place the arc. View the Arc PropertyManager and the
coordinates.

11. Click OK ¥ from the Arc PropertyManager.

12. Rebuild H the model.
13. Close the model.

Tangent Arc Sketch Entity

The Tangent Arc Sketch entity tool provides the ability to create an arc, which is tangent
to a sketch entity. The Tangent Arc Sketch entity uses the Arc PropertyManager. View
the Centerpoint Arc Sketch entity section above for additional information on the Arc
PropertyManager.

w1

“¥* You can transition from sketching a line to sketching a Tangent Arc, and vice versa
without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the
endpoint of the line. Move your mouse pointer away. The Preview displays another line.
Move your mouse pointer back to the selected line endpoint. The Preview displays a
tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint.

Perform the same procedure above to continue.
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Tutorial: Tangent Arc 4-1

Create a Tangent Arc sketch. ¢ B[RSO >
1. Create a New L part. Use the default ANSI Part template. |7

@ Part3 (Default<<Default>_Displ

2. Right-click Front Plane from the FeatureManager.

History
3. Click Sketch c from the Context toolbar. sensors.
Y Annotatlons
4. Click the Line 7 Sketch tool. Equations

S Mats[_|® 2 L

{Seten)

F

Sketch a horizontal line through the Origin.

ront Plane)

ﬂ Top =
6. Click Tangent Arc ") from the Consolidated Arc Sketch &Rigph BL 2D Sketch On Plang
toolbar. The Arc icon is displayed on the mouse pointer. L. orig ffd'c’" V:ew
7. Click the left end point of the horizontal line. e o
8. Drag the mouse pointer upward and to the left for
the desired shape.
9. Click an end point. You created a Tangent Arc. The k
Arc PropertyManager is displayed. -
10. Right-click Select in the Graphics window to
deselect the Sketch tool.
11. Click OK ¥ from the Arc PropertyManager.
12. Exit the sketch. Close the model. % &

+

w s
“¥" You can select an end point of a line, ellipse,
arc or a spline. The Tangent Arc tool creates both

Normal and Tangent Arcs.

3 Point Arc Sketch Entity

The 3 Point Arc Sketch entity tool provides the ability to create an arc by specifying three
points: a starting point, an endpoint, and a midpoint. View the Centerpoint Arc Sketch
entity section for additional information on the Arc PropertyManager.

Tutorial: 3 Point Arc 4-1

Create a 3Point Arc sketch. h g @ - A EE
1. Open 3 Point Arc 4-1 from the SOLIDWORKS 2016 folder. -

2. Edit Sketchl.

A Centerpoint Arc
_D Tangent Arc

3. Click 3 Point Arc ¢ from the Consolidated Arc Sketch £ 3 Point Arc
toolbar.
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4. Click the top point of the vertical line for the start point as

illustrated.
5. Click the right point of the open circle for the

end point as illustrated.
6. Drag the arec downward to set the radius.
7. Click a position for the midpoint of the 3Point A

Arc. '
8. Click OK ¥ from the Arc PropertyManager. ° .
9. Rebuild ® the model. -
10. Close the model.
Ellipse Sketch Entity
The Ellipse Sketch entity tool provides the ability to create a © E|R &[]
complete ellipse. The Ellipse PropertyManager controls the © & _
properties of a sketched Ellipse or a Partial Ellipse. The Ellipse pse

v

PropertyManager provides the following selections:

Existing Relations. The Existing Relations box provides the | Bxisting Relations
following options: b

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.

® Under Defined

The Information icon in the Existing Relations box Add Relations A
displays the sketch status of the selected sketch entity. Fix
Example: Under Defined, Fully Defined, etc.
. . X Options ~
Add Relations. Provides the ability to add relations to the [l For construction
selected entity. Displays the relations which are possible for
Parameters A

the selected entity.
é; -154,62073398

4 F 4 )

Options. The Options box provides the following selection: & 52975
e For construction. Converts the selected entity to . TEEEE |-

construction geometry.
G 10.10699629

1 »

Parameters. Provides the ability to specify any appropriate

combination of parameters to define the ellipse if the ellipse

is not constrained by relations. The available selections are

Center X Coordinate, Center Y Coordinate, Start X

Coordinate (only available for a Partial Ellipse), Start Y Coordinate (only available
for a Partial Ellipse), End X Coordinate (only available for a Partial Ellipse), End Y
Coordinate (only available for a Partial Ellipse), Radius 1, Radius 2 and Angle
(only available for a Partial Ellipse).

Page 4 - 33



Design Intent, Sketching and Sketch Entities SOLIDWORKS® 2016 Reference Guide

Tutorial: Ellipse 4-1

Create an Ellipse sketch. @ TL A | Entities Ent
1. Create a New L part. Use the default Ellipse
ANSI Part template. = Partial Ellipse
2. Right-click Front Plane from the V Parabola
FeatureManager. This is your Sketch ) s

plane.

3. Click Sketch C from the Context toolbar.

4. Click the Ellipse & Sketch tool. The Ellipse icon is
displayed on the mouse pointer.

5. Click the origin in the Graphics window. This is the start
location.

6. Drag and click to set the major axis of the ellipse. The
ellipse PropertyManager is displayed.

7. Drag and click again to set the minor axis of the
ellipse.

Deselect the sketch tool.
8. Right-click Select in the Graphics window.

Add a vertical geometric relation in the sketch.
9. Hold the Ctrl key down.

10. Click the top vertical point and the bottom
vertical point of the Ellipse.

11. Right-click Make Vertical from the Pop-up menu.
12. View the sketch.
13. Close the model.

Partial Ellipse Sketch Entity

The Partial Ellipse Sketch entity tool provides the ability to
create a partial ellipse or an elliptical arc from a centerpoint, a
start point, and an end point. You used a similar procedure
when you created a Centerpoint Arc. The Ellipse
PropertyManager controls the properties of a sketched Ellipse
or a Partial Ellipse. View the Ellipse section for additional
information on the Ellipse PropertyManager.
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Parabola Sketch Entity

The Parabola Sketch entity tool provides the ability to create a
parabolic curve. The Parabola Sketch entity uses the Parabola
PropertyManager. The Parabola PropertyManager provides the
following selections:

Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.

Options. For construction. Not selected by default.
Converts the selected entity to construction geometry.

Parameters. Provides the ability to specify the appropriate
combination of parameters to define the parabola if the
parabola is not constrained by relations. The available
selections are Start X Coordinate, Start Y Coordinate,
End X Coordinate, End Y Coordinate, Center X

Coordinate, Center Y Coordinate, Apex X Coordinate and

Apex Y Coordinate.

Tutorial: Parabola 4-1
Create a Parabola sketch.

1.

3.

Create a New U part. Use the default ANSI, IPS Part
template.

Right-click Front Plane from the FeatureManager. This is
your Sketch plane.

Click Sketch C from the Context toolbar.

Apply the Parabola Sketch tool.

4.

Click the Parabola \J Sketch tool from the Consolidated
Sketch toolbar. The Parabola icon is displayed on the mouse
pointer.
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>
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5. Click a position in the Graphics window to locate the
focus of your parabola.

6. Drag to enlarge the parabola. The parabola is outlined.

7. Click on the parabola and drag to define the extent of
the curve. The Parabola PropertyManager is displayed.

8. Click OK ¥ from the Parabola PropertyManager.

9. Rebuild ¢ the model.
10. Close the model.

P . G B & | & G B[4 &
Conic Sketch Entity S N | = .
"\ Conic (] "\ Conic 7
The Conic Sketch entity M tool provides the 7 v
ability to sketch conic curves driven by Options _ ~ | | Existing Relations ~
endpoints and Rho value. Depending on the g: E‘t’“”“d'"” h
0 langency

Rho value, the curve can be elliptical,
parabolic, or hyperbolic. In previous versions of the
SOLIDWORKS software, you could sketch ellipses and parabolas.
However, you could not sketch ellipses or parabolas by their

@ Under Defined

endpoints, so it was difficult to make them tangent to existing Add Relations
geometry. Lo

Conic curves can reference existing sketch or model geometry, or | %" ”

they can be standalone entities. You can dimension the curve with

[ For construction

Parameters v

a driving dimension, and the resulting dimension displays the Rho

value. The conic entity also includes a value for the radius of
curvature.

P03z
o032

Conic curve sketch that references existing geometry Preview of revolved sketch

Finished model

w1

‘¥ Auto Tangency accelerates the process of sketching a conic curve.
When you select this option in the Conic PropertyManager, you set the first and second
endpoints for the conic curve. The Conic tool applies tangent relations at each endpoint
of the curve and selects the top vertex of the curve. This option is helpful when you
reference existing geometry. If you clear this option, you must define the top vertex of
the curve.
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The Conic Sketch entity uses the Conic PropertyManager. The
Conic PropertyManager provides the following selections:

Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.

Options. The Options box provides the following selection:

e For construction. Not selected by default. Converts the
selected entity to construction geometry.

Parameters. Provides the ability to specify the appropriate
combination of parameters to define the parabola if the
parabola is not constrained by relations. The available
selections are Start X Coordinate, Start Y Coordinate,
End X Coordinate, End Y Coordinate, Center X
Coordinate, Center Y Coordinate, Apex X Coordinate
and Apex Y Coordinate.

Tutorial: Conic 4-1
Create a Conic sketch.

1.

Open Conic 4-1 from the
SOLIDWORKS 2016 folder. The model
contains an arc and spline.

Apply the Conic Sketch tool.

2.

Click the Conic N Sketch tool from the
Consolidated Sketch toolbar. The Conic

icon is displayed on the mouse pointer. =

Click the first endpoint for the conic
curve as illustrated.

Origin
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10.

11.

12.
13.

Drag the pointer to the right so it’s tangent
with the arc. Because the endpoint is attached
to the existing arc sketch, a yellow inferencing
line is displayed.

Click the second endpoint as illustrated.

Drag the mouse pointer upwards. A yellow
inferencing line is displayed tangent to the
spline sketch.

Drag the mouse pointer out to the intersection
of the two yellow inferencing lines. You can
snap to the intersection of both inference lines
to choose the top vertex of the conic curve.

Click at the intersection of both inferencing
lines to set the top vertex of the conic curve.
By selecting the intersection of both
inferencing lines, you ensure that the conic
curve is tangent at both endpoints.

Drag the pointer to the left until the Rho
value is 0.75. As you move the pointer, the
conic curve's Rho value changes.

Click to set the Rho value to 0.75. Reference
points are displayed for the curve's shoulder
and top vertex. Tangent relations are created
between the curve and the original sketches.

Click OK + from the Conic
PropertyManager.

Rebuild H the model.
Close the model.

Conic surfaces are very useful for precision
flowing (aerodynamic) shapes. It is best to have
no more than one singular point on a surface. The
midline curve is usually shared by the top and
bottom fuselage shape surfaces.

Rho is the squareness for conic, and translates into

the squareness of the surface. In theory at 1.0 itis a

dead sharp corner, 0.8 is a very modern squarish

corner, 0.6 is most useful for airplane fuselages, 0.4
looks like an ellipse, and 0.1 is a slanted ellipse section

that tends toward a line between the end points.
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Spline Sketch Entity

The Spline Sketch entity tool provides the ability to create a profile
that utilizes a complex curve. This complex curve is called a Spline,
(Non-uniform Rational B-Spline or NURB).

Create a spline with control points. With spline control points, you
can:

e Use spline points as handles to pull the spline into the shape you
want.

¢ Add dimensions between spline points or between spline points
and other entities.

e Add relations to spline points.
The 2D Spline PropertyManager provides the following selections:

o Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add Relations
tool. The callout in the Graphics window is highlighted
when you select a relation in the dialog box. The
Information icon in the Existing Relations box displays the
sketch status of the selected sketch entity. Example: Under
Defined, Fully Defined, etc.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for the
selected entity.

SEEE®
(\J Spline £l
v
Existing Relations [v] =
Add Relations ~
Options ~

I:‘ For construction
[T show curvature

Maintain internal
7 Ttain |
continuity

Parameters A~
i 1

M -173.56388302

4 1) 1

M 3632932609

x 0.00

¥ | 6461305611

A |7227464625°
[[I1angent driving
Reset This Handle

Reset All Handles

Relax Spline

[ proportional

l

e Options. The Options box provides the following

JEIEEE

selection:

e For construction. Not selected by default. Converts the
selected entity to construction geometry.

e Show Curvature. Not selected by default. Provides the
ability to control the Scale and Density of the curvature.
Displays the Curvature of the spline in the Graphics
window.

g’ Curvature Scale

Page 4 - 39



Design Intent, Sketching and Sketch Entities SOLIDWORKS® 2016 Reference Guide

Maintain Internal Continuity. Selected by default. Maintains the spline's
internal curvature. When Maintain Internal Continuity is cleared, the curvature
scales down abruptly.

Raised degree. Available only with splines that include curvature handles at each
end. Raises or lowers the degree of the spline. You can also adjust the degrees by
dragging the handles.

Raised degree

e Parameters. Provides the ability to specify the appropriate combination of
parameters. The available parameters are:

Spline Point Number. Highlights your selected spline point in the Graphics
window.

X Coordinate. Specifies the x coordinate of your spline point.
Y Coordinate. Specifies the y coordinate of your spline point.

Radius of Curvature. Controls the radius of curvature at any spline point. This
option is only displayed if you select the Add Curvature Control option from the
Spline toolbar, and add a curvature pointer to the spline.

Curvature. Displays the degree of curvature at the point where the curvature
control was added. This option is only displayed if you add a curvature pointer to
the spline.

Tangent Weightingl. Controls the left tangency vector by modifying the spline’s
curvature at the spline point.

Tangent Weighting 2. Controls the right tangency vector by modifying the
spline’s curvature at the spline point.

Tangent Radial Direction. Controls the tangency direction by modifying the
spline’s angle of inclination relative to the X, Y or Z axis.
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e Tangent Polar Direction. Controls the elevation angle of the tangent vector with
respect to a plane placed at a point perpendicular to a spline point. This is only for
the 3D Spline PropertyManager.

e Tangent Driving. Enables spline control by using the Tangent Magnitude option
and the Tangent Radial Direction option.

e Reset This Handle. Returns the selected spline handle to the initial state.
e Reset All Handles. Returns the spline handles to their initial state.

¢ Relax Spline. Sketch your spline and display the control polygon. You can drag
any node on the control polygon to change shape. If the node you are dragging
results in a spline which is not smooth, re-select the spline to display the
PropertyManager. Click the Relax Spline selection under the Parameters option.
This will re-parameterize or smooth the shape of your spline.

e Proportional. Retains the spline shape when you drag the spline.

Spline toolbar Spline Tools X

L -
Use the tools located on the Spline toolbar to control
properties of a sketched spline. The Spline toolbar provides % A

the following tools:

e Add Tangency Control. The Add Tangency Control tool

7 adds a tangency control handle. Drag the control
handle along the spline and position it to control the tangency at the selected point.

e Add Curvature Control. The Add Curvature Control tool /O adds a curvature control
handle. Drag the control handle along the spline and position the control handle to
control the spline shape at the selected point.

e Insert Spline Point. The Insert Spline Point tool r adds a point to the spline. Drag
spline points to reshape the spline.

s
i

You can insert dimensions between the spline points.
o Simplify Spline. The Simplify Spline tool % reduces the number of points in the

spline. This function improves the performance in the model for complex spline
curves.

e Fit Spline. The Fit Spline tool = adds a spline based on the selected sketch entities
and edges.
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e Show Spline Handles. The Show Spline Handles tool el displays all handles of the
selected spline in the Graphic window. Use the spline handles to reshape the spline.

e Show Inflection Points. The Show Inflection Points tool A displays all points where
the concavity of a selected spline changes.

o Show Minimum Radius. The Show Minimum Radius tool /™Y displays the
measurement of the smallest radius in the selected spline.

e Show Curvature Combs. The Show Curvature Combs tool & displays the scalable
curvature combs which visually enhances the curves of your selected spline.

Tutorial: 2D Spline 4-1

Create a 2D Spline sketch. m # ©

1. Create a New LJ part. Use the default ANSI, IPS Part M/ Spline -
template. AF Style Spline

2. Right-click Right Plane from the FeatureManager. | % Equation Driven Curve

This is your Sketch plane.

3. Click Sketch C from the Context toolbar.

Apply the Spline Sketch tool.
4. Click the Spline [V Sketch tool. The spline icon is
displayed on the mouse pointer.

5. Create the Spline. This is an open profile. Create a
seven point control spline as illustrated. Do not
select the origin. The Spline PropertyManager is
displayed.

6. Right-click Select on the last control point.
7. Exit the Spline [V tool. l_

8. Click and drag the spline from left to right. Do not
select a control or handle. The spline moves without
changing its shape. <

9. Click OK ¥ from the Spline PropertyManager.

10. Rebuild H the model. View the results.
11. Close the model.
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AR Spline handles are displayed by default. To hide or display spline handles, click the

Show Spline Handles el tool from the Spline toolbar or click Tools > Spline Tools »
Show Spline Handles.

Tutorial: 2D Spline 4-2

Dimension a 2D Spline sketch handle.

1. Open 2D Spline 4-2 from the
SOLIDWORKS 2016 folder.

2. Edit Sketchl.

Use the Smart Dimension tool to
dimension a spline handle. Display the
handles.

3. Click the Spline in the Graphics
window. The Spline
PropertyManager is displayed.
Locate the pointer on the top

handle. The rotate © icon is displayed.
4. Click the top handle tip.

5. Rotate the handle upwards as illustrated to create a Tangent
Driving.
6. Right-click Smart

Dimension L from the
Context toolbar.

Create a Tangent Radial
dimension.
7. Click the handle arrow tip.

8. Click the horizontal line.
9. Enter 40deg.
10. Set precision to none. = X

11. Click OK ¥ from the
Dimension PropertyManager.

Modify

qu Angle i

4l]|d eg E

View the results. e n
12. Close the model. 1, [None z)
b il [.12 (Document) v]
“¥" For a Tangent Magnitude, select the arrow tip on the handle

to add the dimension.
s

¥* Tllustrations may vary depending on your SOLIDWORKS
version and system setup.
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Tutorial: 3D Spline 4-1
Create a 3D Spline Sketch.

1. Create a New U part. Use the default ANSI Part
template.
2. Click Insert > 3D Sketch from the Menu bar menu. ﬁ‘ L
Y
Apply the Spline Sketch tool. X

3. Click the Spline /V Sketch tool.

4. Click a location in the Graphics window to

place the first spline point. Each time you
click a different location, the space handle
is displayed to help you sketch on a
different plane. IR
ey Y X

A Press the Tab key to change planes in a
3D Sketch.

5. Click three additional locations as

illustrated. The Spline PropertyManager is

displayed.
6. Right-click Select on the last control point. L
7. Exit the 3D Sketch. 3DSketchl is created /

and displayed in the FeatureManager. First point
8. Close the sketch.

Last point
Tutorial: 3D Spline 4-2
Edit a 3D spline sketch using the current elements.
1. Open 3D Spline 4-2 from the SOLIDWORKS
2016 folder.
2. Edit 3DSketchl.
3. Click the Spline in the Graphics window. The / ¥

Spline PropertyManager is displayed.

Modify the Spline shape using the click and drag

method on a control point.

4. Click a spline control point as illustrated and
drag it upward. The Point PropertyManager is
displayed. View the results.
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Modify the Spline shape using the x-, y- and

z- coordinates method on a control point.

5. Click a spline point as illustrated. The Point
PropertyManager is displayed.

6. Set values for x-, y-, and z- coordinates from
the Point PropertyManager. You modified the
shape of the spline. L

Modify the Spline shape using the click and drag

method on a handle. Parameters

7. Click a spline handle as illustrated. 200 A

8. Drag the selected spline handle to control the .x 2000 :
tangency vector by modifying the spline’s L i
degree of curvature at the spline point. The o, 500] 1

Spline PropertyManager is displayed.

Reset the handle to the original location.

9. Click the Reset This Handle option. All values
relative to the selected handle return to their ; Py
original value. e

rE’F’

Move the spline.
10. Click and drag the spline from left to right. Do L
not select a control point. As the spline is

moved, it retains its shape. [¥|Tangent Driving
Reset This Handle

11. Click OK ¥ from the Spline PropertyManager.
12. Exit the 3D Sketch. View the results. —
elax >pline

13 Close the mOdel. Proportional

Reset All Handles

Tutorial: 3D Spline 4-3

Add new elements to a 3D Spline.
1. Open 3D Spline 4-3 from the

SOLIDWORKS 2016 folder. ~
2. Edit 3DSketchl.
3. Click the spline from the Graphics
window. The Spline PropertyManager is I,.

displayed.

Spline Tool
4. Click the Add Tangency Control 7 tool e 100

from the Spline toolbar. - o L.

6l% A &
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5. Drag to place the handle as illustrated.
6. Click a position for the handle.
7. Click OK ¥ from the Spline

PropertyManager.
8. Exit the 3D Sketch. View the results.
9. Close the model. L
-
Style Spline

The Style Spline & tool provides the
ability to sketch single-span Bézier curves. o R
These curves let you create smooth and robust :
surfaces, and are available in 2D and 3D
sketches.

The Style Spline consists of only one span. You
shape its curvature by selecting and dragging
control vertex points. Sketch entities connect
the control vertices which form the control
polygon of the curve.

With the Style Spline tool, you can control the degree and
continuity of the curves. You can inference style splines
for tangency or equal curvature. You can constrain the
points and dimension the curves' sides. These curves also
support mirroring and self-symmetry.

Spline on Surface Entity

The Spline on Surface entity @ tool provides the

ability to sketch splines on various surfaces. Splines

sketched on surfaces include standard spline

attributes, as well as the capabilities to add and drag

points along the surface and to generate a preview

that is automatically smoothed through the points. L

w s

“¥" All spline points are bounded to the surface on
which they are sketched.
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Tutorial: Spline on Surface 4-1

Create a Closed Spline on Surface feature.

1.

Open Spline on Surface 4-1 from the
SOLIDWORKS 2016 folder.

Click the top left face as illustrated.

Click the Spline on Surface ® Sketch tool. The
spline icon is displayed on the mouse pointer.

Create a five point closed spline as illustrated.

Click OK v from Spline PropertyManager to
close the sketch tool.

Click the Extruded Boss/Base Features tool. The
Boss-Extrude PropertyManager is displayed.

Design Intent, Sketching and Sketch Entities

v e e

©

@ Spline on Surface

Click the left vertical line as

llustrated for Direction 1. D"°“'°“ 5
Edge<1> is displayed in the
Direction of Extrusion box.

Enter 10mm for Depth.

I

& [20.00mm

Click OK ¥ from the Boss- 7] Merge resuit

Extrude PropertyManager. Boss- |

=

Extrudel is displayed. View the

. . . ft d
results in the Graphics window. [orat outwar

10. Close the model.

Splines on surfaces can:

Span multiple faces.

Update if model geometry is updated (unless the
splines are constrained).

You can move the points on the spline to different
faces by dragging the points but not by dragging the
curve itself.
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Intelligence Modeling - Equation Driven
Curve

The Equation Driven Curve % tool is a 2D Sketch spline driven
by an equation. This Sketch entity provides the ability to create a
curve by specifying the equations that define the curve. Equations
defining a curve specify y- as a function of x-. You can use any
function that is supported in the Equations dialog box. See
Chapter 18 - Intelligence modeling techniques for additional
information.

The Equation Driven Curve entity uses the Equation Driven
Curve PropertyManager. The PropertyManager provides the
following selections:

o Equation Type. There are equation types available: Explicit
and Parametric.

e Parameters. The Parameters box provides the following
options:

e Equation. Provides the ability to enter an equation as a
function of X-. If you enter an equation that can’t be
resolved, the text color is displayed in red.

e Parameters. Provides the ability to enter the start and end
X value of the equation.

e Transform. Provides the ability to enter the
translation of X-, Y- and angle for the curve.

Tutorial: Equation Driven Curve 4-1

Create an Equation Driven Curve on the Front Plane.

1. Create a New L part. Use the default ANSI, IPS Part
template.

Create a 2D Sketch on the Front Plane.
2. Right-click Front Plane from the FeatureManager.

3. Click Sketch from the Context toolbar. The Sketch toolbar is
displayed. Front Plane is your Sketch plane.
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ﬁ Equation Driven Cu...

v x

Message -~

Enter an equation in terms of x
where the resulting y values are
calculated according to the start
value x1 and the end value x2.

Equation Type -~
(@ Explicit
() parametric

Parameters ~

Equation

Yx

Parameters
Xi
X; G

&

v ¥ ©
{\J Spline
AF Style Spline

NA  Equation Driven Curve

SEE[®]®] >
¥

@ Part3 (Default<<Default>_Disp
History

Sensors

Annotations

Equations

-
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4. Click the Equation Driven Curve % Sketch tool. The

. . L ) G B o @
Equation Driven Curve PropertyManager is displayed. This & OIS
tool provides the ability to build intelligences into a part. % Equation Driven Cu_. @

L ®
Specify the equation that defines the sketch. Note: y- is a function
of x-. Message o ~
5. Click Explicit for Equation Type. i ?:SE'FE.—:;”;E;TJZ? -
calculated according to the start
6. Enter 3*x*sin(x) as illustrated in the Equation value x1 and the end value 2.
box. “ Equation Type ~
. . @ Explici
7. Enter 0 for the start point as illustrated. © e
8. Enter 4*pi for the end point. Note: You can fix Parameters ~
the end points of the curve by applying the Fix p Fquation
tOOl. yx I**sing)
Parameters
9. Click OK ¥ from Equation Driven Curve x° B
PropertyManager. View the created curve. xmm ]
Note: click the curve in the Graphics window to ’ =
edit the Parameters of the curve. u

10. Click Exit Sketch. View the results.
11. Close the model.

w1

“¥" Use regular mathematical notation and order of operations to write an equation. x;
and x» are for the beginning and end of the curve. Use the transform options at the bottom
of the PropertyManager to move the entire curve in X-, y- or rotation. To specify x=f(y)
instead of y = f(x), use a 90 degree transform.

w1

“¥* View the .mp4 provided movies in the book to better understand the potential of the
Equation Driven Curve tool. The first one is Calculating Area of a region bounded by
two curves (secx)”2 and sin x in SOLIDWORKS; the second one is Determine the
Volume of a Function Revolved Around the x Axis in SOLIDWORKS. Both are located in
the SOLIDWORKS 2016 folder.

. Il m
Curve Through XYZ Points ﬂ
. U . @ Project Curve
The Curve Through XYZ Points & feature provides the B Composie Curve
ability to either type in (using the Curve File dialog box) “g Euwe I:mug::’f Pﬂimsp N
or click Browse and import a text file using x-, y-, z- B e

coordinates for points on a curve.

A text file can be generated by any program which

creates columns of numbers. The Curve [ feature
reacts like a default spline that is fully defined.

BOIUE | x| Al

@

= (o (=

8 % (& |58

o |3 al | =||a

g & |« B[ |3
L

CAG HiIs
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Create a curve using the Curve Through XYZ Points tool. Import the x-, y-, z- data.
Verify that the first and last points in the curve file are the same for a closed profile.

w1

A It is highly recommend that you insert a few extra points on either end of the curve
to set end conditions or tangency in the Curve File dialog box.

Imported files can have an extension of either *.sldcrv or *.text.
The imported data: x-, y-, z-, must be separated by a space, a comma, or a tab.

Tutorial: Curve Through XYZ points 4-1

Create a curve using the Curve Through XYZ Points tool. Import x-, y-, z- data from a CAM

program. Verify that the first and last points in the curve file are the same for a closed profile.
1. Open Curve Through XYZ points 4-1 from the SOLIDWORKS 2016 folder.

2. Click the Curve Through XYZ Points S tool from the U o
Features CommandManager. The Curve File dialog box is Curves| | jtant3D
displayed.
AN
Import x-, y-, z- data. Verify that the first and last points in the curve [ 9 cune Through xvz points
file are the same for a closed profile. i = Helix and Spiral

3. Click Browse from the Curve File dialog box.

4

iCunres (~sldcrv) I

Browse tO the SOLIDWORKS 2016 fOlder. Curves (*sldcrv)

4
5. Set file type to Text Files.
6

Double-click cam2.text. View the data in the Curve File : ':JSOOLBOX
dialog box. View the sketch in the Graphics window. Review ) camasa
the data points in the dialog box. 7 3
7. Click OK from the Curve File dialog box.
Curvel is displayed in the FeatureManager. Curve File -
Thls curve can now be used in a SketCh (fU—Hy Ci\Users\David\Documents\2016 SolidWorks Re: Browse...
defined profile). View the results of the fully Point M v n
defined sketch using the curve. L somm _omn e [ see
8. Close the model. el
5 49.88mm 351mm C —
9. Open Curve Through XYZ points 4-2 from 5 | 298omm|  asamm c e )
the SOLIDWORKS 2016 folder to view the e B
a 49.56mm 7A41mm (g
final model and FeatureManager. & .

10. Close the model.

w1

¥ See Chapter 18 - Intelligence Modeling
techniques for additional information.
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Curve Through Reference Points T -
“al
ERRES Instant3D
The Curve Through Reference Points B (o0l provides the N
ability to create a curve through points located on one or @ Spit Line

more planes. See SOLIDWORKS Help for additional

information. @ Project Curve
R1 Composite Curve

U Curve Through XYZ Points
@ Curve Through Reference Points
B Helix and Spiral

Point Sketch Entity

© ER[¢ Q]
The Point Sketch entity tool provides the ability to insert points in s Point 7
your sketches and drawings. To modify the properties of a point, v
select the point in an active sketch, and edit the properties in the Existing Relations .
Point PropertyManager. The Point PropertyManager provides the L
following selections:
o Existing Relations. The Existing Relations box provides the
following options: @® Under Defined
e Relations. Displays the automatic relations inferenced Add Relations ~
during sketching or created manually with the Add Relations Fix
tool. The callout in the Graphics window is highlighted when |~ R
you select a relation in the dialog box. The Information icon o e -
in the Existing Relations box displays the sketch status of the | | .o <
selected sketch entity. - -

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for the
selected entity.
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e Parameters. Provides the ability to specify the appropriate combination of parameters
for your point only if the point is not constrained by relations. The available
parameters are:

e X Coordinate. Specifies the x coordinate of your point.

e Y Coordinate. Specifies the y coordinate of your point.

Centerline Sketch Entity QER[®[S]

The Centerline Sketch entity tool provides the ability to use /" Insert Line I

centerlines to create symmetrical sketch elements and revolved M

features, or as construction geometry. The Centerline sketch Message ~

entity uses the Insert Line PropertyManager. The Insert Line e

PropertyManager provides the following selections: It €7 2 EET 2 T T
Orientation ~

e Orientation. The Orientation box provides the following

options: © s sketched

| Horizontal

e As sketched. Sketch a line in any direction using the
click and drag method. Using the click-click method, the

As sketched option provides the ability to sketch a line in | Options ~
any direction, and to continue sketching other lines in any [¥]For construction
direction, until you double-click to end your process. [CJmfinite length

[ midpoint line

e Horizontal. Sketch a horizontal line until you release
your mouse pointer.

e Vertical. Sketch a vertical line until you release your
mouse pointer.

e Angle. Sketch a line at an angle until you release your mouse pointer.

s
AT

The angle is created relative to the horizontal.
e Options. The Options box provides two line types. They are:

¢ For construction. Selected by default. Converts the selected sketch entity to
construction geometry.

¢ Infinite length. Not selected by default. Creates a line of infinite length which
you can later trim in the design process.

e Midpoint line. Creates a line that is symmetrical from the midpoint of the line.

w1

“¥* Use Construction geometry to assist in creating your sketch entities and geometry
that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a

centerline.
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Text Sketch Entity

SHERREAEED
The Text Sketch A entity tool provides the ability to sketch text e ST
on the face of a part and extrude or cut the text. Text can be vox
inserted on any set of continuous curves or edges. This includes T A
circles or profiles which consist of lines, arcs or splines. A
w1 o
“¥* Convert the sketch entities to construction geometry if the Text A

curve is a sketch entity, or a set of sketch entities, and your sketch |
text is in the same sketch as the curve.

The Text sketch entity uses the Sketch Text PropertyManager. The
Sketch Text PropertyManager provides the following selections:

e Curves. The Curves box provides the following options:

e Select Edges, Curves Segment. Displays the selected EE=E
curves, edges, sketches, or sketch segments.

e Text. The Text box provides the following options: A [100% i
e Text. Displays the entered text along the selected entity in afs [ "

the Graphics window. If you do not select an entity, the text [¥] Use document font
is displayed horizontally starting at the origin.

e Bold Style. Bold the selected text.

Font...

e Italic Style. Italicize the selected text.
e Rotate Style. Rotate the selected text.

e Left Alignment. Justify text to the left. Only available for
text along an edge, curve or sketch segment.

e Center Alignment. Justify text to the center. Only available for text along an
edge, curve or sketch segment.

e Right Alignment. Justify text to the right. Only available for text along an edge,
curve or sketch segment.

e Full Justify Alignment. Justify text. Only available for text along an edge, curve
or sketch segment.

e Flip. Provides the ability to flip the text.
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e Flip Vertical direction and back. The Flip Vertical option is only available for
text along an edge, curve or sketch segment.

¢ Flip Horizontal direction and back. The Flip Horizontal option is only available
for text along an edge, curve or sketch segment.

e Width Factor. Provides the ability to widen each of your characters evenly by a
specified percentage. Not available when you select the Use document's font
option.

e Spacing. Provides the ability to modify the spacing between each character by a
specified percentage. Not available when your text is fully justified or when you
select the Use document's font option.

e Use document's font. Selected by default. Provides the ability to clear the initial
font and to choose another font by using the Font option button.

e Font. Provides the ability to choose a font size and style from the Font dialog

box.
Tutorial: Text 4-1 g% @ c B m
- set X
Apply text on a curved part. Use the Sketch Text tool. f Entities Entities pivoe BB Li
1. Open Text 4-1 from the SOLIDWORKS 2016 folder. Text o
The Lens Cap is displayed in the Graphics window. [} Sketches text. You can sketch text on
| faces, curves, edges, and sketch
2. Click Front Plane from the FeatureManager. entities.

Apply the Text Sketch tool.

3. Click the Text A Sketch tool. The Sketch Text
PropertyManager is displayed.

4. Click inside the Text box. [
5. Type SOLIDWORKS. SOLIDWORKS is displayed l

horizontally in the Graphics window starting at the origin,
because you do not select an entity.

6. Click the front edge of Base Extrude. Edge<1> is \-'
displayed in the Curves option box. The SOLIDWORKS \\
text is displayed on the selected edge.

7. Uncheck the Use document font box.
8. Enter 250% in the Spacing box.

9. Click the Font Button. The Choose Font dialog box is
displayed.

10. Select Arial Black, Regular, Point 14.
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11. Click OK from the Choose Font dialog box.

12. Click OK v from the Sketch Text PropertyManager. Sketch7 is created and is
displayed in the FeatureManager. Zoom in on the created text.

13. Close the model.

w1

“¥* If the curve is a sketch entity, or a set of sketch entities, and the sketch text is in the
same sketch as the curve, convert the sketch entities to construction geometry.

Plane Sketch Entity SE[R[&[®]
il Sketch Plane ?
The Plane Sketch entity tool provides the ability for the user to DR

add Reference entities to a 3D sketch. Why? To facilitate
sketching, and to add relations between sketch entities. Once you | Message &
add the plane, you need to activate it to display its properties and | Select references (planes, sketch

entities, edges, faces or vertices)

to create a sketch. The Plane sketch entity uses the Sketch Plane to define the sketch plane. Then

select the constraining relations

PropertyManager. to each reference,
The Sketch Plane PropertyManager provides the following First Reference ~
selections: @I
o First Reference. Provides the ability to select Reference
entities from the FeatureManager or from the Graphics Second Reference ~
window. Select the constraining relations to each reference. #)
The available relations selection is based on the selected
geometry. Third Reference ~

¢ Reference Entities. Displays the selected sketch entity or ﬁal
plane as the reference to position the 3D Sketch plane.

e Select a relation. Select a relation based on the selected
geometry.

w s

“¥* The available relations are displayed in the Sketch Plane
PropertyManager under the First, Second and Third Reference.

The relations are based on existing geometry.
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e Second Reference. Provides the ability to select Reference entities from the
FeatureManager or from the Graphics window. Select the constraining relations to
each reference. The available relations selection is based on the selected geometry.

¢ Reference Entities. Displays the selected sketch entity or plane as the reference

to position the 3D Sketch plane.

e Select a relation. Selects a relation based on the selected geometry.

o Third Reference. Provides the ability to select Reference entities from the
FeatureManager or from the Graphics window. Select the constraining relations to
each reference. The available relations selection is based on the selected geometry.

¢ Reference Entities. Displays the selected sketch entity or plane as the reference

to position the 3D Sketch plane.

e Select a relation. Selects a relation based on the selected geometry.

w1

“¥ With existing geometry, add a plane by referencing the entities
that are present. Use any number of references required to achieve

the desired results.

Tutorial: Sketch Plane 4-1

Add a 3D Sketch plane. Add a plane using references. Select two
corner points of a 3D sketch. The corner points of the rectangle

reference the position of the 3D sketch plane.

1. Open Sketch Plane 4-1 from the SOLIDWORKS 2016 folder.

2. Edit 3DSketchl from the
FeatureManager.

3. Click Tools > Sketch Entities > Plane.
The Sketch Plane PropertyManager is
displayed.

w1

“¥* Rename a feature or sketch for clarity.
Slowly click the feature or sketch name
twice and enter the new name when the old
one is highlighted.

S E[E ¢S]
i Sketch Plane ?

v X ™

G| E|R & & »

4
@ Sketch Plane 4-1 (Default<<Def
History
Sensors
v [&) Annotations
[E) Equations
§§ Material <not specified=>

W Front Plane

Message -~

Select references (planes, sketch
entities, edges, faces or vertices)
to define the sketch plane. Then
select the constraining relations
to each reference.

First Reference A~

|

N Top Plane
W Rigl[g[1®
1, orig ¢ 1

Second Reference ~

|

Edit Sketch
(3o 3%
Feature (3DSketchl)

Third Reference ~

I
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4. Click the top front corner point of the rectangle as /L
illustrated. Point3 is displayed in the First Reference
box.

5. Click the bottom back corner point of the rectangle.
Point4 is displayed in the Second Reference box.

6. Click OK v from the Sketch Plane V 1
PropertyManager.

7. Rebuild ® the model. Plane2@3DSketchl is
created and is displayed in the Graphics
window.

8. Close the model.

Route Line Sketch Entity

xplode...[E3) E5]

The Route Line Sketch entity tool provides the 2o S|=[F]e] ﬁ
ability to insert a Route line between faces, circular & 0 @" Route Line 1
edges, straight edges, or planar faces. The Route o
Line Sketch entity is active when you:

Items To Connect A
e Create an Explode Line Sketch. ©
e Edit an Explode Line Sketch. g
e Select the Route Line tool in a 3D sketch. DERe ~

DReverse

The Exploded Line Sketch tool @ is a 3D sketch added to an el sl
Exploded View in an assembly. The explode lines indicate the [¥] Along xvz

relationship between components in the assembly.

The Route Line Sketch entity @” uses the Route Line
PropertyManager. The Route Line PropertyManager provides the following selections:

e Items To Connect. The Items To Connect box provides the following option:

e Reference entities. Displays the selected circular edges, faces, straight edges or
planar faces to connect with your created route line.

e Options. The Options box provides the following selections:

e Reverse. Reverses the direction of your route line. A preview arrow is displayed
in the direction of the route line.

e Alternate Path. Displays an alternate possible path for the route line.

e Along XYZ. Creates a path parallel to the X, Y and Z axis directions.
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w1

-

* Clear the Along XYZ option to use the shortest route.

Tutorial: Route Line 4-1

Create an Explode Line sketch using the Route Line Sketch
entity.

1.

Open the Route Line 4-1 assembly from the
SOLIDWORKS 2016 folder. The assembly is displayed
in an Exploded view.

Click the Explode Line Sketch @* tool from the
Assembly toolbar. The Route Line PropertyManager is
displayed.

Click the inside face of Cut-Extrudel of Shaft-
Collar<1>. The direction arrow points towards the back.
If required, check the Reverse direction box. Face<I>
@Shaft-Collar-1 is displayed in the Items To Connect
box.

Click the inside face of the top hole of Cut-Extrudel of
the Flatbar<I1> component. Face<2>@Flatbar-1 is

displayed in the Items To Connect box. The arrow points

towards the right.

Click the inside face of Cut-Extrude5 of
RodClevis<1>. Face<3>@AirCylinder-1is
displayed in the Items To Connect box. The
arrow points towards the back.

Click the inside face of the second Cut-
Extrude5 feature of RodClevis<I>.
Face<4>@ AirCylinder-1 is displayed in the
Items To Connect box.

Click the inside face of the top hole of
Cut-Extrudel of the Flatbar<2> component.
Face<2>@Flatbar-2 is displayed in the Items
To Connect box. The arrow points towards
the back.
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8. Click the inside face of Cut-
Extrudel of SHAFT-COLLAR<2>.
The direction arrow points towards
the back. Face<1> @Shaft-Collar<2>
is displayed in the Items To Connect
box.

9. Click OK ¥ from the Route Line
PropertyManager. View the created
Route Line.

10. Click OK ¥ from the
PropertyManager to return to the
FeatureManager.

Fit the model to the Graphics

window. Display an Isometric CER[e[©]
view. a7 Route Line 9
11. Press the f key to fit the vox

model to the Graphics Items To Connect ~

Wil’ldOW. [ |Face<1>@shaft-Collar-1
Face<2>@Flatbar-1
Face<3>@AirCylinder-1/R!

Face<4>@AirCylinder-1/R,

12. Click Isometric view.
View the results.

13. Close the model.

w s

Face<2>@Flatbar-2
Face<1=>@Shaft-Collar-2

- Options -~
AR SOLIDWORKS provides : [FlReverse
the ability to create a Bill of Materials (BOM) in an [Jatternate path
assembly. The BOM is displayed in the Tables folder of D
the FeatureManager. You no longer need to create a
drawing to see a BOM. See the Assembly section for
additional information.
Tutorial: Route Line 4-2 A
g . I | &[]
Edit an Explode Line Sketch. —
1. Open Route Line 4-2 from the SOLIDWORKS 2016 R
folder. The Route Line 4-2 Assembly FeatureManager |~ @ Route Line 4-2 Configuration(s
is displayed. ~ T2 « Default [ Route Line 4-2
2. Click the ConfigurationManager tab. P ILTM‘KpIOde
3. Expand Default. Afimate explode
4. Right-click ExplView1 from the
ConfigurationManager.
5. Click Explode. View the results in the Graphics
window.

6. Expand ExplViewl.
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Edit the Explode Line Sketch.
7. Right-click 3DExplodel from the

ConfigurationManager. /EE

8. Click Edit Sketch.

9. Display a Top view.

toolbar. The Insert Line
PropertyManager is displayed. E -

11. Click the endpoints of the Route Line //L_ \

as illustrated.

Create a new path. Pl
12. Click a point to the right of the Route

Line endpoint and over the top of the

axle. ®
13. Click a point below the axle as

tllustrated.

|
|
10. Click Centerline « from the Sketch ‘

14. Click a point to the left of the axle over the Flatbar.
15. Click a point below the Flatbar.

16. Click a point above the SHAFT-COLLAR.

. b LN =&
17. Click a point below the Shaft-Collar. @ PR
Deselect the active Sketch tool. o544
18. Right-click Select in the Graphics window. IS Sgeﬂ |
19. Rebuild & the model. View the results. B Layout

20. Return to the FeatureManager design tree.
21. Close the model.
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Belt/Chain Sketch Entity

This option provides the ability to create layout sketches for pulleys
or sprocket mechanisms. The Belt/Chain feature simulates a cable-
pulley mechanism. The Belt/Chain entity uses the Belt/Chain
PropertyManager.

w1

A8 In the past, it was difficult using SOLIDWORKS to effectively
model components such as cables, chains, and timing belts due to
their flexible motion. The shapes of these items could change over
time. This made it difficult to examine the way a belt would interact
with two or more pulleys, or a cable system shifts a lever, or
crank with a solid assembly model.

The Belt/Chain PropertyManager provides the following
selections:

e Belt Members. The Belt Members box provides the
following options:

e Pulley Components. Displays the selected arcs or
circles for the pulley components.

e Up arrow. Moves the selected pulley component
upwards in the displayed order.

e Down arrow. Moves the selected pulley component
downward in the displayed order.

e Flip belt side. Changes the side on which the belt is
located in the pulley system.

e Properties. The Properties box provides the ability to
define the following belt conditions. They are:

e Driving. Cleared by default. Provides the ability to
calculate the length of your belt. When checked, enter
a value if you do not want the system to calculate
your belt length. Based on the constraints, one or
more of the components may move to adjust for the
length of the belt.

e Use belt thickness. Specifies the thickness value of
the belt.
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T ER ¢S
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v x
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Select the circle or arc to

define belt members around

which the belt will pass

Belt Members -~

1]

[
Flip belt side

Properties -~
Belt Length:
[ oriving
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e [Engage belt. Selected by default. Disengages the belt mechanism.

w1
Eria

Only circle entities in a block can be selected for a belt member.

Blocks C E[R[¢[@]

Make Block
Blocks are a grouping of single or multiple sketch entities. In

SOLIDWORKS, the origin of the block is aligned to the
orientation of the sketch entity. Previously, blocks inherited Block Entities A
their origin location from the Parent sketch. Additional
enhancements to Blocks are:

v X

[-]

e Modeling pulleys and chain sprockets. Insertion Point [~

. . Li ut Sketch Block
e Modeling cam mechanisms. [ElLayout sketch Bloc

Drag Manipulator on-screen
Blocks are used in the Belt/Chain sketch entity. You can create to position insertion point.

blocks from a single or multiple sketch entities.
Why should you use Blocks? Blocks enable you to:
e Create layout sketches using the minimum of dimensions and sketch relations.
o Freeze a subset of sketch entities in a sketch to control as a single entity.

e Manage complicated sketches.

e Edit all instances of a block simultaneously.

“¥* Use blocks in drawings to conserve drawing items such as standard label positions,
notes, etc. See SOLIDWORKS Help for additional information.

Blocks toolbar _ =
2 ] @& W i &

The Blocks toolbar controls blocks in sketching. The
Blocks toolbar provides the following tools:

e Make Block. The Make Block tool provides the ability to create a new block.

e Edit Block. The Edit Block * tool provides the ability to add or remove sketch
entities and to modify dimensions and relations in your sketch.

o Insert Block. The Insert Block = tool provides the ability to add a new block to
your sketch or drawing. This option provides the ability to either create multiple
instances of existing blocks or to browse for existing blocks.

o Add/Remove. The Add/Remove 2 tool provides the ability to add or remove sketch
entities to or from your block.
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e Rebuild. The Rebuild tool provides the ability to update the parent sketches
affected by your block changes.

e Saves Block. The Saves Block tool provides the ability to save the block to a file.
Adds an .sldblk extension.

e Explode Block. The Explode Block = tool provides the ability to explode the
selected block.

e Belt/Chain. The Belt/Chain & tool provides the ability to insert a belt.

w s

A Exploding a single instance of the block only affects that instance of the block.

Tutorial: Block 4-1

Create a Block using the Blocks toolbar.

1. Create a New U part. Use the default ANSI Part
template. ~

2. Click Top Plane from the FeatureManager. This is your
Sketch plane.

3. Sketch a closed sketch using sketch entities as illustrated.
The sketch consists of five lines.

4. Click Make Block from the Block toolbar or click G | | R | & | §|
Tools » Blocks » Make. The Make Block
PropertyManager is displayed.

Make Block

5. Box-select the sketch entities from the Graphics v
window. The selected sketch entities are displayed in Block Entities =
the Block Entities box. tf"e;
6. Expand the Insertion Point box. Note the location of tf”ei
the insertion point. s
7. Click OK ¥ from the Make Block PropertyManager. s
Block1-1 is displayed in the FeatureManager. Insertion Point [y

[ JLayout Sketch Block

8. Rebuild & the model.
9. Close the model.

Drag Manipulator on-screen to position
insertion point.
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w1

-~

* Create a block for a single or combination of multiple Sketch

entities. Saving each block individually provides you with
extensive design flexibility.

Tutorial: Belt-chain 4-1
Use the Belt/Chain Sketch entity function. Create a pulley sketch.

SOLIDWORKS® 2016 Reference Guide

SERRE
4
@@, Belt-chain 4-1 (Default<<I
v History

Sensors

v Annotations

1. Open Belt-chain 4-1 from the SOLIDWORKS 2016 folder. L e
View the three created blocks in the Belt-chain EEEs
FeatureManager 2% Material <not specified
’ W Front Plane
2. Edit Sketchl from the FeatureManager. ¥ Top Plane
3. Click Tools > Sketch Entities > Belt/Chain. The Belt/Chain | N %" [lg% 1;‘ E
PropertyManager is displayed. L, origin
4. Select the three circles from left —
to right. The select circles are ] Ele]®
displayed in the Belt Members Beit/Chain B )
dialog box. v X (=)
5. Check the Driving box. ”T‘”‘-‘: g -~ @@ l.
Select the circle or arc to
6. Enter 460mm for Belt Length. e e bt il oo
7. Check the Use belt thickness boX. | geit Members N Q
8. Enter 20mm for belt thickness. © i[iiﬁﬁﬁﬂﬁlﬁﬂi
rcl /e |_Circle-|
9. Click OK ¥ from the Belt/Chain
PropertyManager. - O]
10. Expand Sketchl. Beltl is created 2 e hn @
and is displayed in the Properties N
FeatureManager. The calculated Belt Length: @
belt length was larger than the belt [Bl oriving N
length entered in the 40mm -
PropertyManager. The system s :—’;;“"C'Te“ ) S T &
moved the entities to correct for S = =
the entered 460mm belt length. [1Engage bet @ Beit-chain 4.1 (Defaultact
v Histol
11. Rebuild H the model. View the results. 53:50?5
12. Close the model. ' ::S:;i::"s
Wl $5 Material <not specified:

A View SOLIDWORKS Help for additional information.

The Select Chain command has been enhanced to allow you
to select construction entities. See SOLIDWORKS Help for
additional information.
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Reuse an existing 2D Sketch

You can use the same sketch to create different features. To create different features with
the same sketch:

e C(Create a sketch.
e C(Create a feature from the sketch.

¢ In the FeatureManager design tree, select the same sketch used to create the first
feature.

e C(Create a second feature from the sketch.

In the FeatureManager design tree, a sketch that is shared by multiple features is
identified by the Shared e icon or by Shared 2l icon for a selected contour.

w1

" Add additional sketches as required to create the features. For example, if one
feature is an extrude and the other feature is a revolve use the same sketch for both
features, but add a centerline to create the revolve.

Tutorial: Shared Sketch 4-1

Create an Extrude Thinl feature with a shared sketch. Bl M

1. Open Shared Sketch 4-1 from the SOLIDWORKS 2016 folder. | @ Boss-Extrude

2. Click Sketch1 from the FeatureManager. View the sketch in the v e
. . From ~
Graphics window. _ _
3. Click Extruded Boss/Base Dlrectlonl -
@ from the Feature toolbar. ' [Midpiane -]

‘L

4. Select Mid Plane for End

Condition in Direction 1. & [16oomm 2]
5. Enter 16.00mm for Depth. M“Qe resut -
-

6. Check the Thin Feature [Coraft outwerd

dialog bOX. [#] Thin Feature

7. Enter 4.50mm for [ w

Thickness. A
8. Click the Reverse Direction button. Selected Contours ~
9. Click inside the Selected Contours dialog box. ©
10. Click the circumference of the large circle in the Graphics

window.

11. Click OK v from the PropertyManager.
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12. Expand Extrude-Thinl in L. origin
the FeatureManager. View ~ @] Extrudel
the Shared sketch. N Sketchl

13. Close the model. ~ @] Extrude-Thinl

N Sketchl

Summary

In this chapter, you learned about the available tools to incorporate Design Intent into a
sketch, feature, part, assembly and drawing.

Sketching is the foundation of a model. You addressed 2D and 3D Sketching and how to
recognize the various Sketch states: Fully Defined, Over Defined, Under Defined, No
Solution Found and Invalid Solution Found along with identifying the correct Reference
plane.

You reviewed the following Sketch Entities: Line, Corner Rectangle, Center Rectangle,
3 Point Corner Rectangle, 3 Point Center Rectangle, Parallelogram, Straight Slot,
Centerpoint Straight Slot, 3 Point Arc Slot, Centerpoint Arc Slot, Polygon, Circle,
Perimeter Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve, Point,
Centerline, Text, Plane, Route line and Belt/Chain.

You utilized and addressed the following toolbars: Block toolbar and Spline toolbar and
applied the Instant3D tool.

Fully define all sketches in the model. However, there are times when this is not
practical, generally when using the spline tool to create a freeform shape.

Use Construction geometry to assist in creating your sketch entities and geometry that are
ultimately incorporated into the part. Construction geometry is ignored when the sketch is
used to create a feature. Construction geometry uses the same line style as a centerline.

s
P

Press the Tab key to change planes in a 3D Sketch.
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You can transition from sketching a line to sketching a Tangent Arc, and vice versa,
without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the
endpoint of the line. Move your mouse pointer away. The Preview displays another line.
Move your mouse pointer back to the selected line endpoint. The Preview displays a
tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint.
Perform the same procedure above to continue.

Rename a feature or sketch for clarity. Slowly click the feature or sketch name twice and
enter the new name when the old one is highlighted.

w1

“¥* The plane or face you select for the Base sketch determines the orientation of the
part.

w s

“¥" The PropertyManager remembers its last used state.

In Chapter 5, explore and address the Sketch tools, 2D to 2D toolbar, Geometric
Relations, Dimensions/Relations toolbar, the DimXpertManager and learn about
TolAnalyst.
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Notes:
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